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1▼  ▼  ▼  ▼
Getting Started
This Array Management Guide explains how to create and manage 
arrays using the software included with your Adaptec® 
Array1000™CA Family adapter. It includes instructions on using all 
the software features and also information on how to replace drives, 
reconstruct arrays, etc. To learn how to install the software (includ-
ing drivers) on your computer, see the Installation and Hardware 
Guide.

The Array1000CA Family includes two array solutions that have 
similar features but use different implementations:

The AAA™-131CA PCI-to-Wide UltraSCSI Array Adapter is a sin-
gle-channel, caching array adapter designed to provide the highest 
data throughput for demanding PC workstation applications. The 
AAA-131CA has both 50-pin and 68-pin internal connectors as well 
as a 68-pin external connector to support up to fifteen UltraSCSI and 
legacy SCSI devices.

The ARO™-1130 RAIDport™ II Card is a RAID co-processor 
upgrade card for RAIDport II On-board systems and motherboards. 
RAIDport II On-board systems and motherboards include a 
RAIDport II connector and one or more Adaptec UltraSCSI ASICs on 
the motherboard. The ARO-1130CA upgrades UltraSCSI channels 
on the motherboard to Adaptec RAID. The ARO-1130CA card itself 
has no internal or external SCSI connectors.
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Array Management Software Overview
Here is a brief description of the array management software 
included with your Array1000CA Family product.

■ ArrayConfigCA™ - After you install the Array1000CA Family 
product in your computer, you use the ArrayConfigCA pro-
gram to create the first array with the convenient Express 
Setup wizard option. ArrayConfigCA asks you a few simple 
questions and then creates a 2-disk array that best fits your 
requirements. (There is also a Custom Setup option for 
advanced users.) ArrayConfigCA runs from a self-booting dis-
kette and is documented in Part 1 (Chapter 2) of this manual.

■ Adaptec CI/O Workstation Array Management Software - 
You use this full-featured program to create, monitor, and 
manage arrays and other devices on your Windows NT™ 
Workstation computer. Adaptec CI/O Workstation Array 
Management Software also enables you to tune and monitor 
the data input/output performance of arrays. This program is 
documented in Part 3 (Chapters 3 through 7) of this manual.

Using the Array Management Software
Here are some general comments on how to use the Adaptec array 
management software most effectively. (Use the Table of Contents 
and the Index to find instructions for specific software commands.)

■ Use ArrayConfigCA to create the first array on your computer. 
We recommend that you use the Express Setup option to 
quickly and easily create the array.

■ If you want the fastest possible data input and output from the 
array, select Optimized for Performance in Express Setup. If 
your main concern is protecting the data on the array from 
disk failure, select Optimized for Data Protection.

■ Use Adaptec CI/O Workstation Array Management Software 
to create additional arrays and to monitor the performance and 
status of arrays and other devices in your computer.

■ If your arrays are Optimized for Data Protection, you should 
add and configure spare disks for the arrays. You can add and 
delete spares with ArrayConfigCA and with Adaptec CI/O 
Workstation Array Management Software.
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■ Use Adaptec CI/O Workstation Array Management Software 
to test fault-tolerant arrays and spares. Respond immediately 
to arrays in Critical status. Replace failed spare disks promptly.

■ Use the password feature of Adaptec CI/O Workstation Array 
Management Software to protect your system configuration.

Conventions and Advisories
This document uses the following typographic conventions:

bold
Used for key names (… press the Enter key …) and for options 
you are told to select (… select Configure SCSI Channels…).

Helvetica
Used for screen messages (…Save changes?…) and for text 
that must be typed exactly as shown.

Helvetica Italics
Used for program and file names when referenced in the text 
(… these changes are made to the config.sys file…).

This document uses two kinds of advisories:

Note: This kind of advisory presents reminders, tips, or sug-
gestions for using the array management software.

Caution: This kind of advisory cautions you about actions 
that could destroy data or damage the computer system.

Use caution when handling any electrical equipment. Advisories in 
this document can only cover the procedures contained here, and 
not all situations may have been addressed. Adaptec does not claim 
to have included every condition or situation that might require a 
Caution or Warning. You must refer to the documentation for your 
computer and peripheral devices when you are installing equipment 
or changing its configuration.

❒
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2▼  ▼  ▼  ▼
Using the ArrayConfigCA 
Program
This chapter explains how to use the ArrayConfigCA program to cre-
ate arrays on your system. You can use ArrayConfigCA in two ways:

■ Choose Express Setup if you want to create an array quickly 
and easily. ArrayConfigCA asks you a few simple questions 
and uses your answers to create the kind of array that best 
meets your needs.

■ Choose Custom Setup if you want to have more control over 
the array configuration or if you want to add spare disks to the 
array.

ArrayConfigCA runs from a convenient, self-booting diskette. 
Nearly all ArrayConfigCA functions can also be performed with 
Adaptec CI/O Workstation Array Management Software, which 
runs under Windows NT.

See the Installation and Hardware Guide provided with your Adaptec 
array card for information on connecting SCSI devices, installing 
software, preparing to run ArrayConfigCA, and creating your first 
array with ArrayConfigCA.
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Creating an Array with Express Setup
ArrayConfigCA’s Express Setup option allows you to quickly create 
a two-disk array for your system by answering some basic questions 
about what kind of array you want. This process is similar to the 
“wizards” used in many Windows programs. When you use the 
Express Setup option you do not need to know the technical details 
of how arrays are configured.

Follow these steps to create an array with the Express Setup. (You 
can probably complete the Express Setup process by simply follow-
ing the instructions that appear on the screen.)

Note: To select ArrayConfigCA menu options, type the hot 
key—the letter that appears in a different color. (The hot key 
letters are underlined in the following instructions). You can 
also press the ↑ and ↓ keys until the option is highlighted 
and then press Enter.

1 Insert the ArrayConfigCA diskette in drive A and reboot your 
computer. Wait until ArrayConfigCA starts automatically.

2 Read the text that appears on the initial ArrayConfigCA 
screens. Press any key to view the next screen, or press Esc to 
return to the previous screen.

3 When you see the Setup Type Selection Menu, select Express 
Setup.

4 When the next screen appears, select the type of array you 
want to create:

– Select Optimized for Performance if you want the fastest 
possible data input and output from the new array. This 
type of array does not have special data protection features, 
however; if one disk fails, all data on the array is lost. When 
prompted, type the number of disks you want in this array.

– Select Optimized for Data Protection if your main concern 
is to protect the files on the array from disk failure. This 
type of array safeguards files in the array even if one of the 
array disks fails. (This kind of array has two disks by defi-
nition, so you will not be prompted to enter the number of 
disks you want in the array.)
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5 When the next menu appears, select the type of application 
that you will run on your computer. (Select Others if you are 
not sure what type of application you will use.) 
ArrayConfigCA will use your answer to create the best array 
configuration for your applications.

6 When the next menu appears, select a boot order for the new 
array.

– Select Disk Array will be Boot Drive (recommended) if 
you want your computer to boot from the new array. If you 
selected Optimized for Data Protection in Step 4, booting 
from an array safeguards the information on your boot 
drive. If you selected Optimized for Performance, booting 
from an array improves operating system performance. (To 
boot from an array, you must also install the operating sys-
tem software on the array, as described in the Installation 
and Hardware Guide for your Adaptec Array1000CA family 
product.)

– Select Disk Array will not be a Boot Drive if you do not 
want your computer to boot from the new array.

7 When you have finished all these menu selections, wait while 
ArrayConfigCA creates the array. This may take a long time, 
especially if the disk drives are large.

A message appears when the array has been created. An error 
message appears if fewer than two disks are available or if 
ArrayConfigCA encounters some other problem. If this hap-
pens, install more disk drives or run ArrayConfigCA again and 
use the Custom Setup option.
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Creating an Array with Custom Setup
ArrayConfigCA’s Custom Setup option allows advanced users to 
create arrays with customized configuration and to manage arrays 
that are already created. (You can also perform these advanced 
options with Adaptec CI/O Workstation Array Management Soft-
ware, which is described in Part 2 of this document.) Use Custom 
Setup if you want to

■ delete an array

■ initialize an array

■ add or delete spare disks

■ make an existing array the boot array

Follow these instructions to create an array with Custom Setup.

1 Insert the ArrayConfigCA diskette in drive A and reboot your 
computer. Wait until ArrayConfigCA starts automatically.

2 Read the text that appears on the initial ArrayConfigCA 
screens. Press any key to view the next screen, or press Esc to 
return to the previous screen.

3 When you see the Setup Type Selection Menu, select Custom 
Setup. Then wait while ArrayConfigCA scans your system for 
information about your host adapter and SCSI devices.

4 When the Main Menu appears, select Disk Array Operations.

5 Select Create New Array from the Disk Array Operations 
menu.

6 Type a name for the array and press Enter. The name can be up 
to 15 characters long and can include spaces and any other 
printable characters.

7 Select an array type from the following options:

– RAID 0: Data is striped across the disks in a RAID 0 array, 
allowing for faster data input and output than a single 
disk. RAID 0 arrays do not store redundant data; if any 
disk in the array fails, all data is lost. (This is the type of 
array that is created if you choose Optimized for Perfor-
mance under Express Setup.)
2-4



Using the ArrayConfigCA Program
– RAID 1: Data is mirrored on one pair of disks. If one disk 
fails, data is still safe. The actual usable data capacity of the 
array equals half the available disk space. (This is the type 
of array that is created if you choose Optimized for Data 
Protection under Express Setup.)

See Selecting a RAID Level for an Array on page 9-4 for more 
information on selecting a RAID level.

8 Type the number of drives you want in the array, not including 
spare drives, and press Enter. The number of drives available 
for assignment is listed on the screen.

Note: This step only applies if you are creating a 
RAID 0 array; RAID 1 arrays have two drives by 
definition.

9 When the next screen appears, press Tab to highlight a channel 
(if your Adaptec array card uses more than one SCSI channel). 
Select drives for the array by pressing the ↑ and ↓ keys until 
the drive name is highlighted, and then press Ins or Enter. The 
names of selected drives appear in the box on the right side of 
the screen.

To select drives on a different channel (if necessary) press Tab 
to select another channel and then select the drives from the 
SCSI IDs on Channel menu. To deselect the drive you most 
recently added, press Del.

Caution: A warning appears if you select a disk that 
has partitions. Do not select disks with partitions if 
they contain data you want to keep, because any exist-
ing data will be erased when the disk becomes part of 
the array.

When you have selected the number of drives you specified in 
step 8, the next screen appears automatically. If you are creat-
ing a RAID 1 array, and if there are any unassigned drives, the 
screen prompts you to define spare drives for the array.
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Note: A spare must have at least the capacity of the 
smallest drive in the array.

10 If you do not want a spare, type n and continue with step 12. If 
you want to select dedicated spares, follow these steps:

a At the prompt, type y.

b At the next prompt, type 1 or 2.

c Select one or two spares, using the same method you used 
to select disks for the array.

11 When the Initialize Mode menu appears, select Initialize 
Array to Zero. This operation begins immediately. A graph on 
the screen shows the progress of this operation.

Caution: If the drives contain data, all the data is lost 
when you initialize the array.

Select Low-Level Format only if the drives were previously 
formatted on another system or if you think they may have 
surface defects. Low-level formatting takes a long time for 
large disk drives. (See Initializing an Array on page 2-9 for more 
information.)

12 When the menu of block sizes appears, select a block size. (This 
menu does not appear if the array is a mirrored array with only 
two drives.)

The default block size (64 KBytes) gives the best overall 
performance. The allowable block sizes are 8, 16, 32, 64, and 
128 KBytes.
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Note: If your disk drives initialize very slowly when 
you create arrays, you may be able to speed them up 
by changing a setting in the arconfig.ini file (located on 
the ArrayConfigCA diskette). To do this, open 
arconfig.ini in a text editor and find this line: rem 
WriteSame=Yes. Delete the letters rem and save the 
file in text-only format. The next time you run 
ArrayConfigCA the disks should initialize faster.

13 When you see the message Initialization of [array name] is com-
plete, press any key to return to the Disk Array Operations 
menu.

14 To create additional arrays (if disks are available), return to 
Step 5. When all arrays are created, exit from ArrayConfigCA, 
remove the ArrayConfigCA diskette, and reboot the computer. 
After you reboot you can write data to the arrays.

Other Custom Setup Options

Making the Array Bootable
Follow these steps if you want your computer to boot from the 
newly created array or if you want to change the boot order of exist-
ing arrays:

1 Select Display Boot Order from the Main Menu. The Boot 
Order for Singles and Arrays window appears.

2 If the newly created array is listed as Unit 0 at the top of the list, 
no changes are necessary; if it has some other unit number, 
highlight the array name and press Enter to select it.

3 Use the arrow keys to move the selected array to the top of the 
list. Then press Enter to deselect it.

4 When you are finished, press Esc to return to the Main Menu.

Note: You cannot use this procedure to change the boot 
order of a stand-alone SCSI disk drive. If you want to do 
this, create a one-disk RAID 0 array from the disk.
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For more important information on creating a bootable array, see the 
Installation and Hardware Guide for your Adaptec array card.

Displaying Array Information
Follow these steps to display information about existing arrays 
defined in your computer:

1 Select Disk Array Operations from the Custom Setup Main 
Menu.

2 Select Display Arrays from the Disk Array Operations menu.

3 When the list of arrays appears, highlight the array for which 
you want information and press Enter.

4 View the information that appears on the screen. This includes 
array type and status, array size, and information about each 
disk in the array.

5 Press any key to return to the Disk Array Operations menu.

Deleting an Array

Caution: All data is lost when you delete an array! Before 
you delete an array, back up any data you want to keep.

Follow these steps to delete an array:

1 Select Disk Array Operations from the Main Menu.

2 Select Delete Array from the Disk Array Operations menu.

3 When the list of arrays appears, select the array you want to 
delete.

Caution: A warning appears if you select an array that 
has partitions. Do not delete an array with partitions if 
it contains data you want to keep, because any exist-
ing data will be erased. Be especially careful not to 
select your boot array!

4 View information about the array and make sure you really 
want to delete it. Press any key to continue.
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5 Type y to delete the array (or n to cancel the operation).

6 When the message [Array name] deleted appears, press any 
key to continue.

The drives that were formerly part of the array can now be used as 
stand-alone drives or as members of another array. Deleting an array 
may change the boot order and the drive assignment of other arrays 
and disks.

Note: If the drive assignment changes, you can identify indi-
vidual drives by blinking the drive lights while you are run-
ning Adaptec CI/O Workstation Array Management 
Software. For more information, see Blinking the Drive Light 
on page 5-16.

Initializing an Array
When you create a new array in Custom Setup, you are automati-
cally prompted to initialize (format) it. You can also select the 
Format/Initialize Array option as a separate Custom Setup com-
mand. This could be necessary to reinitialize an array that has 
become corrupted.

Here is some additional information on the two initialization 
methods:

■ Initialize Array to Zero: (Recommended method) Fills the 
array with zeroes. This option is faster than a low-level format, 
but it does not verify the integrity of the disks.

■ Low-level Format: Performs a low-level SCSI format. This 
writes a consistent pattern to the disks, checks the disks for 
defects, and fills the array with zeroes. Low-level formatting 
can take a long time if the disks are large. You cannot abort a 
low-level format once it has started.

Caution: Formatting or initializing an array erases all data 
on the array and cannot be aborted once it has started. If the 
array contains data you want to keep, be sure to back it up 
first!
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Follow these steps to initialize an array:

1 Select Disk Array Operations from the Main Menu.

2 Select Format/Initialize Array from the Disk Array Operations 
menu.

3 When the list of arrays appears, select the array you want to 
initialize.

4 Type y to confirm that you want to initialize the array.

Caution: A warning appears if you select an array that 
has partitions. Do not initialize an array with partitions 
if it contains data you want to keep, because any exist-
ing data will be erased. Be especially careful not to ini-
tialize your boot array!

5 When the Select Format Mode menu appears, select Initialize 
Array to Zero (recommended) or Low-Level Format.

6 When the list of block sizes appears, select a block size. The 
allowable block sizes are 8, 16, 32, 64 (the default), or 
128 KBytes. (This menu does not appear if the array is a mir-
rored array with only two drives.) The default block size gives 
the best overall performance. Formatting begins immediately.

7 When you see the message Initialization of [array name] is com-
plete, press any key to return to the Disk Array Operations 
menu.
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Creating and Deleting Spares
Dedicated spare disks (spares) are an important data protection and 
real-time recovery feature of RAID 1 arrays. (RAID 0 arrays do not 
support spares.) Up to two dedicated spares can be defined for each 
RAID 1 array. If a disk in an array fails while the computer is run-
ning, a spare is activated immediately to take its place. The array 
software automatically reconstructs the necessary data on the new 
disk, and array operation continues uninterrupted.

Adding a Dedicated Spare
When you create an array you have the option of adding one or two 
dedicated spares to it. You can also add dedicated spares to an exist-
ing array at a later time.

You cannot add dedicated spares to an array if

■ The array already has two dedicated spares

■ The remaining single disks are not at least as large as the small-
est disk in the selected array

Follow these steps to add one or two dedicated spares to an already-
existing RAID 1 array:

1 Select Disk Array Operations from the Main Menu.

2 Select Add/Delete Spare Drive from the Disk Array Opera-
tions menu.

3 Select the array to which you want to add the dedicated spare.

4 Select Add Spare Drive from the Add/Delete Spare menu.

5 Select a SCSI channel on the left, if necessary, and then press → 
to move to the list of disks on the right. Disks are grayed out if 
they are already used in an array or if they are smaller than the 
members of the array. Highlight an available disk and press 
Enter. Then select another disk for the second spare, if 
necessary. The new dedicated spare is added immediately.
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Caution: A warning appears if you select a disk that 
has partitions. Do not select disks with partitions if 
they contain data you want to keep, because any exist-
ing data will be erased. Be especially careful not to 
select your boot disk as a spare!

6 Press any key to continue.

Deleting a Dedicated Spare
Follow these steps to delete a dedicated spare:

1 Select Disk Array Operations from the Main Menu.

2 Select Add/Delete Spare Drive from the Disk Array Opera-
tions menu.

3 When the list of spare drives appears, select the one you want 
to delete and press Enter.

4 Select Delete Spare Drive from the Add/Delete Spare Drive 
menu. The dedicated spare is deleted immediately.

5 Press any key to continue. The disk that was formerly a dedi-
cated spare can now be used as a spare for another array or as a 
member of a new array.

❒
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Configuring Arrays and 
Spares
This chapter explains how to use Adaptec CI/O Workstation Array 
Management Software to add and delete arrays and spares on your 
Windows NT Workstation computer. The following topics are 
explained in this chapter:

■ Creating an Array on page 3-2

■ Making an Array the Boot Device on page 3-8

■ Deleting an Array on page 3-9

■ Initializing an Array on page 3-10

■ Creating Dedicated Spares or a Spare Pool on page 3-12

■ Deleting a Spare on page 3-15

Starting the Program
Follow these steps to start the Adaptec CI/O Workstation Array 
Management Software and prepare to configure arrays and spares.

1 Start Windows NT.

2 Double-click the  icon in the Adaptec CI/O Workstation 
Array Management Software group to start the program.
3-1



Adaptec Array1000CA Family Array Management Guide
3 If the Storage Configuration window does not open automati-

cally, open it by clicking the  icon on the toolbar.

Creating an Array
Follow these steps to create arrays with Adaptec CI/O Workstation 
Array Management Software.

1 Start Adaptec CI/O Workstation Array Management Software 
and open the Storage Configuration window, as described in 
Starting the Program on page 3-1. This window looks similar to 
the one shown in Figure 3-1.

The icons on the left side of the Storage Configuration window 
represent the computer’s physical resources—the Array1000CA 
Family device, channels, and SCSI devices installed in your 
computer. The icons on the right side represent the computer’s 
Array resources—the arrays and spares you define. You click the 
buttons in the middle of the window to perform operations on 
selected device icons.

2 Before you start defining the new array, decide what RAID 
level you want to use, how many disks you want it to have, 

Figure 3-1. Storage Configuration Window
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and whether you want to define dedicated spares for the 
array). The following table lists your array options. See Select-
ing a RAID Level for an Array on page 9-4 for information on the 
advantages and disadvantages of each RAID level.

3 Select disks for the new array by clicking disk icons that 
have the word Single beneath them, as shown in Figure 3-2.

Do not include disks that you want to use as spares. Click a sec-
ond time on an icon to deselect it, or click the Clear Selection 
button if you want to deselect all disk icons.

1 This is the maximum number of disks supported by the software driver. The maximum for your 
computer may be less, depending on how many SCSI channels and devices you have.

2 The purpose of one-disk RAID 0 arrays is to give you more control over the virtual device order 
of disks connected to SCSI channels controlled by the Array1000CA Family device.

PERFORMANCE TIP:
If your main reason for creating an array is speed-
ing up your computer’s data I/O performance, 
you should create a RAID 0 array with at least two 
disks. RAID 0 arrays do not use spare disks, so you 
can ignore any instructions about dedicated spares 
or spare pools.

RAID Level
Minimum # of 
Disks Allowed

Maximum # of 
Disks Allowed 1

Dedicated 
Spares Allowed

RAID 0 (Striped) 12 16 None

RAID 1 (Mirrored) 2 2 1 or 2

Figure 3-2. Selecting Array Members
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Do not select a disk that has a partition. If the partition is rec-
ognized by the operating system, you cannot use the disk in the 
array.

You are prevented from using disks with recognized partitions 
for the array so you will not accidentally erase the computer’s 
boot disk. To find out if a disk has a partition, double-click the 

icon and click the Check Partitions button in the SCSI 
Information dialog box. A small popup box indicates whether 
the selected disk has a partition and whether the partition is 
visible to the operating system. If you really want to use a disk 
with a recognized partition in the array, exit from Adaptec 
CI/O Workstation Array Management Software, back up any 
data you want to keep, and delete the partition from the disk.

Caution: All data on a disk is deleted when it becomes an 
array member! Back up any data you want to keep 
before selecting a disk as an array member.

4 Click the Create Array... button. The Create Array dialog box 
appears, as shown in Figure 3-3.

Figure 3-3. Create Array Dialog Box
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The number of disks in the array and the array capacity are 
listed on the right of the dialog box.

5 Type a name for the new array. The name can be up to 15 char-
acters, including spaces and any other printable characters. It 
is used to display the array and to identify the source of event 
notifications.

6 Select a RAID level for the array by clicking one of the buttons 
on the left. The bar graphs on the right show you the relative 
levels of data protection, read performance, write perfor-
mance, and capacity utilization for each RAID level.

RAID levels are grayed out if they are not consistent with the 
number of disks you have selected. (See the table on page 3-3.)

7 (Optional) If you created a RAID 1 array, select one or two ded-
icated spares for it from disks on the scrollable list. (Use Ctrl-
Click to select multiple disks.) The disks on the list are the sin-
gle disks you did not select as array members. Select spares 
that are at least as large as the smallest array member. Other-
wise the usable capacity of each array member will be reduced 
to the capacity of the spare. (See Creating Dedicated Spares or a 
Spare Pool on page 3-12 to learn how to create a spare pool that 
can be used by any array.)

8 (Optional) Click the Advanced... button to examine or change 
the Advanced Array options. The Advanced Array Options 
dialog box appears. See Setting Advanced Array Options on 
page 3-7 for more information.

9 Click OK and then click Yes to confirm that you want to create 
the array. You will see error messages if your array selections 
are inconsistent. If this happens, change your selections and 
click OK again. You will see a warning if you selected a dedi-
cated spare that is smaller than the array members.

The array is initialized at this point, unless you deselected 
auto-initialize in Advanced Array Options. (If you deselected 
auto-initialize, skip to step 11.) If you want to abort the initial-
ization process (not recommended), open the Array Activity 

Monitor window, select the icon for that array, and 
click Abort.
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10 Wait until the new array is initialized. A popup box will 
appear to inform you that event notifications are waiting and 
can be viewed in the Historic Event Log. Then an icon like this 

for the new array appears in the right-hand section of 
the Storage Configuration window. Another event notification 
is generated when the initialization process finishes.

Note: Event notifications may appear as popups or just 
as entries in the Historic Event Log, depending on the 
Event Notification options you selected in the Client 
Settings dialog box.

11 Exit from Adaptec CI/O Workstation Array Management Soft-
ware. Then reboot the computer. (You cannot use the new 
array until you reboot.) You must then partition the new array 
with the Windows NT Disk Administrator, just as you would 
partition a new stand-alone disk drive.
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Setting Advanced Array Options
The Advanced Array Options dialog box is shown in Figure 3-4. Do 
not change these options from their default settings unless you fully 
understand what the options mean and you have a specific reason 
for changing them.

Here is a brief description of the advanced options:

■ Stripe Size is the size that will be used to stripe data across the 
disks in the array. The optimal stripe size depends on the type 
of data being stored on the array and the operating system. 
The default stripe size of 64 KBytes works best in most cases.

■ Deselect auto-initialize if you want to create the array now but 
initialize it at a later time. You might want to do this if you plan 
to define several arrays and initialize them all at the same time.

Caution: RAID 1 arrays must be initialized before you 
can write data to them. We recommend that you zero-
initialize RAID 0 arrays as well.

■ Click the Restore Defaults button if you want to restore the 
Advanced Array Options settings to the way they were when 
you opened the dialog box.

■ Click the Caching button if you want to set Read/Write cach-
ing options for the array. For more information on this option, 
see Using Read and Write Caching on page 7-1.

Figure 3-4. Advanced Array Options Dialog Box
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Making an Array the Boot Device
Use this command if you want the computer to boot from an array 
instead of from a stand-alone disk. (If you want to use a stand-alone 
SCSI disk as your boot device, we recommend that you assign SCSI 
ID 0 to this device. If your computer has multiple SCSI channels, 
connect this SCSI disk to SCSI Channel A.)

You make an array bootable by assigning it virtual device order #0. 
The virtual device order is the sequence in which the computer’s oper-
ating system detects the arrays, single disks, and other installed 
devices when the computer boots.

Caution: When you make an array the boot device, the drive 
letters assigned to other drives and arrays on the computer 
may change, which can cause data access problems. If you 
create a bootable array with ArrayConfigCA, you will have 
more control of the virtual device order of all SCSI devices 
on the computer. See Making the Array Bootable on page 2-7 
for more information.

Follow these steps to create a bootable array:

1 Start Adaptec CI/O Workstation Array Management Software 
and open the Storage Configuration window, as described in 
Starting the Program on page 3-1.

2 Click the icon in the right-hand part of the window 
for the array that you want to make bootable.

3 Click the Operations button.

4 Click the button.

5 When the message appears, click OK to confirm that you want 
to make this array the boot device.

6 Exit from Adaptec CI/O Workstation Array Management Soft-
ware. If the selected array does not already have a bootable 
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partition on it, reboot the computer to a floppy disk or to a 
CD-ROM drive.

7 Install the operating system on the array. See the Installation 
and Hardware Guide for more information.

The next time you boot the computer, it will attempt to use this array 
as the boot device.

Deleting an Array

Caution: Back up the data on an array before you delete it. 
All data on the array disks is lost when you delete the array.

If you delete an array, all the disks that were part of the array 
become single, stand-alone disks. You can then use the disks as spares 
or as members of a new array. 

Follow these steps to delete an array:

1 Start Adaptec CI/O Workstation Array Management Software 
and open the Storage Configuration window, as described in 
Starting the Program on page 3-1.

2 Click the icon in the right-hand area of the window 
for the array you want to delete.

3 Click the Operations button.

4 When the Array Operations dialog box appears, click the 

 button to delete the array.

A warning appears if the selected array has a partition. If the 
partition is recognized by the operating system, you cannot 
delete the array. If the partition is not recognized by the operat-
ing system, you can delete the array.

You are prevented from deleting an array with a recognized 
partition so you will not accidentally delete the computer’s 
boot array. To find out if an array has a partition, double-click 
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the icon and click the Check Partitions button in the 
Array Information dialog box. A small popup box indicates 
whether the selected array has a partition and whether the par-
tition is visible to the operating system. If you really want to 
delete an array with a recognized partition, exit from Adaptec 
CI/O Workstation Array Management Software, back up any 
data you want to keep, and delete the partition from the disk. 
Then start Adaptec CI/O Workstation Array Management 
Software again and delete the array.

5 When the confirmation message appears, click OK to confirm 
that you want to delete the array.

Note: After you delete an array you can immediately use the 
disks that formerly belonged to the array to create spares or 
a new array without rebooting the computer. However, you 
must reboot the computer before you can use the disks as 
single disks that are not members of an array. Deleting an 
array may change the boot order and the drive assignment.

Initializing an Array
When you create a new array it is initialized immediately by default 
unless you deselect the auto-initialize option, as described on 
page 3-7. If you deselect auto-initialize, you can initialize the array 
later by following the instructions in this section. You can also reini-
tialize an existing array, if necessary.

Caution: All arrays except RAID 0 arrays must be initialized 
or formatted before you can write data to them. We recom-
mend that you zero-initialize RAID 0 arrays as well. All pre-
existing data on the disks is overwritten when you initialize 
an array.

If you want to low-level format the array instead of initializing it 
with zeros, use the ArrayConfigCA program. Low-level formatting 
checks the surface of the disks for defects.
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Follow these steps to initialize an array:

1 Start Adaptec CI/O Workstation Array Management Software 
and open the Storage Configuration window, as described in 
Starting the Program on page 3-1.

2 Click the icon of the array you want to initialize. The 
Operations button becomes active.

3 Click the Operations button.

4 When the Array Operations window appears, click the 

button.

A warning appears if the selected array has a partition. If the 
partition is recognized by the operating system, you cannot ini-
tialize the array. You are prevented from initializing an array 
with a partition so you will not accidentally erase the com-
puter’s boot array. To find out if an array has a partition, dou-

ble-click the icon, and click the Check Partitions 
button in the Array Information dialog box. A small popup 
box indicates whether the selected array has a partition. If you 
really want to initialize an array with a partition, exit from 
Adaptec CI/O Workstation Array Management Software, back 
up any data you want to keep, and delete the partition from 
the disk. Then start Adaptec CI/O Workstation Array Manage-
ment Software again and initialize the array.

5 When the confirmation message appears, click Initialize to 
confirm that you want to initialize the array.

To abort the initialization process (not recommended), open 

the Array Activity Monitor window, select the icon, 
and click Abort.

It may take a long time to initialize an array. If you wish, you can 
watch the progress of the initialization process in the Array Activity 
Monitor window.
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Creating Dedicated Spares or a Spare Pool
Each RAID 1 array can have one or two dedicated spares, which auto-
matically replace failed array members only for that array. You can 
create dedicated spares when you create the array, or you can add 
them to the array at a later time. Each Array1000CA Family device 
can have a spare pool of up to eight disks which automatically replace 
failed members of any RAID 1 array whose disks are controlled by 
the card.

If you have two or more RAID 1 arrays, a spare pool protects the 
arrays with fewer disks than what would be required for dedicated 
spares.

Note: When you install Adaptec CI/O Workstation Array 
Management Software it is automatically configured to test 
all spares on the computer once a day to assure they are 
always available, if needed, to replace failed disks in arrays. 
We recommend that you leave this default setting so that all 
spares are tested regularly.

Follow these steps to add a dedicated spare or a pool spare:

1 Start Adaptec CI/O Workstation Array Management Software 
and open the Storage Configuration window, as described in 
Starting the Program on page 3-1.

2 Select the disk you want to configure as a spare by clicking on 
its icon in the left-hand part of the window. (Choose a disk that 
has the word Single beneath it.)

3 Click Create Spare... The Create Spare dialog box appears, as 
shown in Figure 3-5. A list of already-defined spares appears 
on the right. Names of existing arrays appear on the left only if 
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the disk you selected is large enough to protect that array as a 
spare.

Note: In the Storage Configuration window, pool 
spares are labeled p-spare and dedicated spares are 
labeled d-spare in both the left and right parts of the 
window.

4 If you want to dedicate the spare to a specific array, select Ded-
icated To and click the array name in the scrollable list. If you 
want to add the spare to the pool of spares available to all 
arrays on the controller, do not select the Dedicated To box.

5 Click OK to create the spare. A warning message appears if 
you select a disk that has a partition. If the partition is recog-
nized by the operating system, you cannot use the disk as a 
spare. If the partition is not recognized by the operating system 
(for example, if the disk was previously partitioned under 
another operating system), you can use the disk as a spare.

You are prevented from using disks with recognized partitions 
so you will not accidentally erase the computer’s boot disk. To 

find out if a disk has a partition, double-click the icon 
and click the Check Partitions button in the SCSI Information 

Figure 3-5. Create Spare Dialog Box
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dialog box. A small popup box indicates whether the selected 
disk has a partition and whether the partition is visible to the 
operating system. If you really want to use a disk with a recog-
nized partition as a spare, exit from Adaptec CI/O Workstation 
Array Management Software, back up any data you want to 
keep, and delete the partition from the disk.

Newly-created spares are immediately available for use, with-
out rebooting the computer. If an array is in Critical status, it 
will be reconstructed as soon as you create the spare (unless 
the spare is dedicated to another array).

Note: You can add a disk of any size to the spare pool, even 
if the disk is too small to protect the existing arrays. For 
example, if you have created two arrays with 8-GByte disks, 
you can add a 4-GByte disk to the spare pool, even though 
this disk is too small to replace any failed array member. 
The spare pool feature is designed like this to give you addi-
tional flexibility. For example, you may be planning to cre-
ate another array later with 4-GByte disks.

To see which arrays are protected by an existing spare, select the 
spare in the Existing Spares list; the arrays covered by this spare are 
highlighted in the Existing Arrays list. You can double-click an array 
or a spare to view detailed information about it.

To see which spares protect an existing array, select the array in the 
Existing Array list. The spares that protect the array are highlighted 
in the Existing Spares list.
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Deleting a Spare
Follow these steps to delete a spare disk:

1 Start Adaptec CI/O Workstation Array Management Software 
and open the Storage Configuration window, as described in 
Starting the Program on page 3-1.

2 Click the icon in the Array part of the window for the spare 
you want to delete.

3 When the confirmation message appears, click OK to confirm 
that you want to delete the spare.

After you delete an existing spare, and before you reboot the com-
puter, you can use a former spare to create a new array or spare. 
However, this disk does not become visible to the operating system 
as a single disk until after you reboot the computer.

❒
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4▼  ▼  ▼  ▼
Viewing Array, Device, and 
System Information
Adaptec CI/O Workstation Array Management Software allows you 
to view information about arrays, spares, SCSI channels, and SCSI 
devices installed in your computer. You view this information in the 
Storage Configuration window. Follow these steps to open the Stor-
age Configuration window:

1 Select Configuration from the View menu, or click the  
icon on the toolbar.

2 When the Storage Configuration window appears, double-
click the icon that represents the device for which you want to 
view information. The icons for the more commonly used 
devices are as follows:

– Array

– Spare

– ARO-1130CA card or AAA-131CA adapter

– Channel
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– Disk Device

– CD-ROM Drive

Note: There are also icons for SCSI tape drive, CD 
changer, SCSI printer, SCSI scanner, etc.

The array and spare icons appear on the right side of the Stor-
age Configuration window. The icons representing the 
Array1000CA Family device, channels, and SCSI devices 
appear on the left side of the window.

The following sections explain the information that appears when 
you click an icon for a virtual or physical device.

Viewing Array Information

When you double-click an array icon  in the Storage Config-
uration window, the Array Information dialog box appears, as 
shown in Figure 4-1.

Figure 4-1. Array Information Dialog Box
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The following information appears in the Array Information dialog 
box:

■ Status: current status of the array, such as On-line, Off-line, 
Fault-tolerant, Critical, etc.

■ Model: model name of the Adaptec Array1000 product.

■ Array type: RAID level of the array. The supported levels are 
RAID 0 and RAID 1.

■ Capacity: total usable disk space available in the array, in 
MBytes.

■ Member size: size of the array members.

■ Array members: number of disks in the array.

■ Dedicated spares: number of spare disks dedicated to this 
array, if any.

■ Available pool spares: number of pool spares available to pro-
tect this array.

Click the Check Partitions button to determine if the array has a 
partition. A small dialog box indicates whether the selected array 
has a partition and whether the partition is visible to the operating 
system.

Click the Caching button to view information about the array’s 
Read and Write caching options. (The caches exist in memory on the 
Array1000CA Family device.) For more information, see Using Read 
and Write Caching on page 7-1.

When you click the Detail button, you can view the following addi-
tional information about the array:

■ Stripe size: data striping size used on this array.

■ Virtual device order: the sequence in which the operating sys-
tem detects this array when it boots. If the array’s virtual 
device order is 0, then this array is the first device the operat-
ing system detects at boot time.

■ Creation date: date on which the array was created.

■ Date of last verify: date on which the array was last verified. 
See Verifying Array Integrity on page 5-6 for information on 
how to verify an array.
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■ Date of last reconstruct: date on which the array was last 
reconstructed. See Reconstructing an Array on page 5-2 for 
information on how to reconstruct an array.

Click Close to close the Array Detail and Array Information dialog 
boxes.

Viewing Spare Information

When you double-click a spare icon in the right side of the Stor-
age Configuration window the Spare Information dialog box 
appears, as shown in Figure 4-2.

When you double-click a spare icon in the left side of the window 
you will see the SCSI Information dialog box, the same as for a sin-
gle SCSI disk.

The Spare Information dialog box shows which array the spare is 
dedicated to, whether it is a member of a spare pool, its capacity, and 
its current status. An Available status means the spare is fully func-
tional and is available to replace a failed array disk.

Note: The spare icons in the Storage Configuration window 
are labeled p-spare for pool spares and d-spare for dedi-
cated spares.

Click Close to close the Spare Information dialog box or SCSI Infor-
mation dialog box.

Figure 4-2. Spare Information Dialog Box
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Viewing Array Card Information

When you double-click an array card icon , the Controller 
Information dialog box appears, as shown in Figure 4-3.

The information in the Controller Information dialog box is self-
explanatory. The PCI bus number field indicates which PCI slot the 
Array1000CA Family device is installed in.

Click the Capabilities button to view a list of the features supported 
by this Array1000CA Family device. The list is informational only; 
you cannot enable or disable the capabilities on the list. Here are 
some controller capabilities that may appear on the list:

■ Automatic Verify: indicates that the product automatically 
verifies SCSI parity.

■ Auto Fix: indicates that the product automatically corrects data 
miscompares.

■ Supported RAID Levels: lists the RAID levels the product 
supports.

■ Maximum Number of Spares: lists the maximum number of 
pool spares that the product supports.

■ Maximum Number of Physical Arrays: lists the maximum 
number of arrays the product supports.

■ Maximum Number of Drives for a Single Array: lists the 
maximum number of disks the product supports for a single 
array.

Figure 4-3. Controller Information Dialog Box
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■ Maximum/Minimum Stripe Size: lists the range of data and 
parity stripe sizes that the product supports.

■ Spare Pool: indicates that the product supports using spares 
from a spare pool.

Click Close to close the Capabilities dialog box and the Controller 
Information dialog box.

Viewing Channel Information

When you double-click a channel icon , the Channel Informa-
tion dialog box appears, as shown in Figure 4-4.

The following information appears in the Channel Information dia-
log box:

■ Status: current operational status of the channel (for example, 
Active, Inactive).

■ Channel type: type of this channel—for example, SCSI.

■ Maximum Devices: maximum number of SCSI devices that 
the channel supports. If this number is 16 (for example) it 
means you can connect up to 15 devices, since the channel 
itself counts as one device.

■ Current Devices: number of SCSI devices currently connected 
to the channel.

Click Close to close the Channel Information dialog box.

Figure 4-4. Channel Information Dialog Box
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Viewing SCSI Device Information

When you double-click a SCSI device icon, such as a disk or 

a CD-ROM drive , the SCSI Information dialog box appears, 
as shown in Figure 4-5.

The information in this dialog box is self-explanatory. When you are 
creating an array you can view this dialog box to determine if a disk 
you want to use for the array has partitions on it. Simply click the 
Check Partitions button. A small popup box indicates whether the 
selected disk has a partition and whether the partition is visible to 
the operating system.

Note: You cannot use a disk in an array if it has a partition 
that is visible to the operating system. (This is a safety fea-
ture that prevents you, for example, from accidentally eras-
ing your boot disk.) If you really do want to use a disk with a 
recognized partition in the array, exit from Adaptec CI/O 
Workstation Array Management Software, back up any data 
you want to keep, delete the partition, and then run 
Adaptec CI/O Workstation Array Management Software 
again.

Figure 4-5. SCSI Information Dialog Box
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Click the Blink Drive Light button if you are not sure which physi-
cal device the icon represents. The light on the front of the drive will 
flash briefly. (This option is not available for other kinds of SCSI 
devices, such as CD-ROM drives.)

Click Close to close the SCSI Information dialog box.

Rescanning the Computer
Whenever you boot your computer the operating system software 
scans for installed devices such as arrays and SCSI devices. Adaptec 
CI/O Workstation Array Management Software displays icons for 
these devices in the Storage Configuration window.

Sometimes you need to issue a Rescan command while Adaptec 
CI/O Workstation Array Management Software is running so it can 
“see” a new hardware configuration. You need to do a Rescan if

■ you connect a new SCSI device to a SCSI channel controlled by 
the Array1000CA Family device without using the Pause I/O 
command

■ you remove a SCSI device from a SCSI channel controlled by 
the Array1000CA Family device without using the Pause I/O 
command

A Rescan is done automatically if you pause and resume I/O to an 
array or a device. You do not need to issue a Rescan command to 
detect a failed array member. Adaptec CI/O Workstation Array 
Management Software does this automatically.

Follow these steps to rescan the computer:

1 Click the  button on the toolbar. The Storage Configu-
ration window appears.

2 Click the Rescan button, which appears in the area between 
the Physical Resources and Array areas of the window.

3 When the message appears, click Yes to rescan the computer. 
When the rescan is complete, any hardware changes are 
reflected in the icons in the Storage Configuration window.

4 Click OK when the message appears indicating that the rescan 
was completed successfully.
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Viewing System Event Information
Adaptec CI/O Workstation Array Management Software maintains 
a log of information about array-related events that occur on your 
computer system. The information is saved in a log file and can be 
viewed on the screen. System events include creating or deleting an 
array, verifying the integrity of an array, failure of a disk in an array, 
etc. 

Follow these steps to view the log of system events:

1 Click the  button on the toolbar. The Historic Event Log 
appears, as shown in Figure 4-6.

2 View the system event information. New entries are added to 
the top of the list as they occur. A color-coded circle at the 
beginning of each message indicates its severity. (See the next 
section, Interpreting and Responding to System Event Messages, 
for more information.)

3 To view detailed information about a log entry, double-click 
the entry, or highlight the entry and click the Detail button. 
The Log Detail dialog box appears. Click OK when you are fin-
ished viewing this dialog box.

Figure 4-6. Historic Event Log Window
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4 Click Filter to change the message filter options. These changes 
apply only while the window is open and will revert to the 
defaults if you close the Historic Event Log and open it again. 
We recommend that you leave all boxes checked so all system 
messages will be displayed. Follow the instructions in Setting 
Preferences on page 4-11 if you want to permanently change the 
filter settings.

If you choose to filter out some kinds of messages, the Items 
displayed number above the log entries lists the number of mes-
sages that are actually displayed. The Items total field always 
indicates the total number of messages of all types.

5 Click Clear All to delete all existing log entries. Click Save As 
to save the log to a file.

Note: When you open the Historic Event Log, only the 
most recent log entries are initially retrieved from the 
log file. If you scroll down beyond these entries, 
another groups of entries is retrieved. This avoids the 
delay that might occur if an entire large log file were 
retrieved at one time. To keep the log file from getting 
too large, specify a maximum size for it in the initial-
ization file. (See Appendix A, Configuration Settings.)

6 Close the window when you are finished viewing log entries, 
or minimize it as an icon on the screen.

Interpreting and Responding to System Event Messages
There are three severity levels for system events:

■ Critical event messages (red dot) indicate an array prob-
lem that requires immediate action. An example is an array 
going off-line because two array members have failed. See 
Responding to an Off-line Array on page 9-3 for more 
information.

■ Warning event messages (yellow dot) indicate an array or 
system problem that may require attention. An example is a 
channel on which data I/O is paused.
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■ Informational event messages (green dot) inform you 
about some normal operation, such as creating a new array, 
adding a spare, or verifying an array.

Setting Preferences
You use the Preferences dialog box to specify how you want to be 
notified of system events and what kinds of events you want to view 
in the Historic Event Log. The preferences that you set here remain 
in effect until you change them again.

Follow these steps to change or view event preferences:

1 Click the  button. The Preferences dialog box appears, as 
shown in Figure 4-7.

Figure 4-7. Preferences Dialog Box
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2 Click the Notification button to change the way in which you 
are alerted of event notifications. The Event Notifications 
Options dialog box appears, as shown in Figure 4-8. Select one 
or more of the available options, then click OK to save these 
settings.

Note: Regardless of the options you choose, Adaptec 
CI/O Workstation Array Management Software will 
always notify you of Critical events with a pop-up 
message, a beep, and a flashing title bar.

3 Click the Filter button to view the Log Filter dialog box, as 
shown in Figure 4-9. Select or deselect the check boxes to 
change the filtering of messages in the Historic Event Log, then 
click OK to save these settings.

Figure 4-8. Event Notification Options Dialog Box

Figure 4-9. Log Filter Dialog Box
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We recommend that you select all the boxes so you are fully 
informed of all system events.

4 Click OK to change the option information or to close the Pref-
erences dialog box. These settings are the new default settings 
for the Historic Event Log window.

❒
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5▼  ▼  ▼  ▼
Performing Operations on 
Arrays and Other System 
Devices
You can use Adaptec CI/O Workstation Array Management Soft-
ware to perform a number of operations on arrays, spares, array 
cards, channels, and stand-alone disk drives. These operations 
include reconstructing an array, testing spares, and blinking the 
lights on disks drives, changing Read/Write cache settings, and 
graphing system performance. Some of the operations are per-
formed immediately; others can be scheduled for a later time, or can 
be scheduled to occur at stated intervals.

To perform operations on arrays and other system devices, you first 
open the Storage Configuration window. To do this:

1 Select Configuration from the View menu, or click the 

icon on the toolbar.

2 When the Storage Configuration window appears, single-click 

an icon that represents an array , spare , array 

card , SCSI channel , or SCSI disk .

When you do this, the Operations button becomes active.
5-1



Adaptec Array1000CA Family Array Management Guide
3 Click the Operations button. A dialog box appears with icons 
for the operations that you can perform on the selected device.

4 Click the button for the operation you want to perform. See the 
appropriate section of this chapter for a description of these 
operations.

Performing Array Operations
Here is a list of the array operations. Note that some of these opera-
tions are described in other chapters.

■ Reconstructing an Array on page 5-2

■ Pausing I/O on an Array on page 5-5

■ Verifying Array Integrity on page 5-6

■ Blinking Array Drive Lights on page 5-8

■ Reactivating an Off-line Array on page 5-9

■ Changing an Array Name on page 5-9

■ Forcing a Spare on page 5-10

■ Making an Array the Boot Device on page 3-8

■ Deleting an Array on page 3-9

■ Initializing an Array on page 3-10

■ Optimizing Array Performance (See Using Read and Write Caching 
on page 7-1)

■ Graphing Array Performance (See Graphing System Performance 
on page 7-6)

Reconstructing an Array
If a spare disk is available when a disk in a RAID 1 array fails, the 
data on the disk is automatically reconstructed on the spare, and 
you do not need to use the Reconstruct operation. However, if a disk 
in an array fails and no spare is available to replace it, you receive an 
event notification that the array is Critical. You may need to recon-
struct the array with this command after the drive is replaced. In 
either case, data on the array is not lost.
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You can reconstruct an array immediately after you replace the 
failed disk (recommended), or you can schedule the reconstruct to 
occur at a later time.

Follow these steps to reconstruct a RAID 1 array when a disk fails:

1 Determine which array is in Critical status and which disk in 
the array has failed.

2 If the disks are in an array enclosure, pause I/O to the array. 
(See Pausing I/O on an Array on page 5-5.) If they are installed 
inside a regular computer case, turn OFF the computer, discon-
nect the power cord, and open the computer case.

3 Replace the failed disk with a good disk of at least the same 
storage capacity. Be sure that the SCSI ID of the new disk is dif-
ferent from the SCSI ID of other installed devices. Or, if an 
array disk was accidentally disconnected, reconnect it.

4 Wait until I/O automatically resumes after the pause period. 
Or close the computer case, reconnect the power cord, and turn 
ON the computer.

5 If you installed a new disk (or disks), make the disk into a 
spare by following the directions in Creating Dedicated Spares or 
a Spare Pool on page 3-12. Be sure the new spare disk is at least 
as large as the smallest array member.

Note: When the spare is created, Adaptec CI/O Work-
station Array Management Software should automati-
cally start a Reconstruct operation on the array. If for 
some reason the reconstruct does not begin automati-
cally, follow the remaining steps to perform it 
manually.

6 Select Configuration from the View menu. The Storage Con-
figuration window appears.

7 Click on the array icon that looks like this . The Opera-
tions button becomes active.
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8 Click the Operations button. The Array Operations dialog box 
appears, as shown in Figure 5-1.

9 Click the button. The Scheduler dialog box appears.

10 Enter the required information for the Reconstruct operation in 
the Scheduler dialog box. You can select Immediate to recon-
struct the drive immediately or select Once to schedule the 
operation for a later time. (See Setting Scheduling Options on 
page 6-1 for more information.)

11 Select an Execution Priority - high, medium, or low.

12 Click OK.

13 When the message appears, confirm that you want to recon-
struct the array member.

14 Read the event notifications that appear in the Historic Event 
Log (they may also appear as popups on the screen) to deter-
mine when the reconstruct is complete.

Open a Watch box if you want to monitor the progress of the array 
reconstruction. (See Monitoring Activities that are Running on 
page 6-5.)

Figure 5-1. Array Operations Dialog Box
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Pausing I/O on an Array
Use this option to pause data I/O on an array so you can replace a 
disk on a RAID 1 array, reconnect a loose connection, etc. If your 
computer system includes a special array enclosure that supports 
hot swapping1, you can replace an array disk without pausing I/O.

Note: You can pause data I/O for up to 120 seconds. This is 
enough time to replace a bad disk in an array enclosure, but 
not enough time to replace a bad disk inside a regular com-
puter case. If the array disk you want to replace is not in an 
array enclosure, simply shut down the system, replace the 
bad disk, and restart the system.

When you pause an array, all other devices connected to the 
Adaptec card are also paused. I/O is automatically resumed after a 
specified pause interval. The Pause I/O command is disabled if a 
Verify, Reconstruct, or Initialize operation is running.

Follow these steps to pause and resume I/O on an array:

1 Open the Storage Configuration window and select the icon of 

the array you want to pause.

2 When the Array Operations dialog box appears, click the 

button.

3 When the Pause I/O dialog box appears, enter a pause interval 
that does not exceed the maximum allowable pause period 
(120 seconds), and click OK to pause the array. Wait a few sec-
onds until data I/O stops.

1 Hot swapping support means that the array enclosure electrically isolates the 
bad disk’s SCSI connector from the SCSI bus while the disk is being 
swapped to prevent data corruption. Data can still be transferred to and 
from the remaining good disks while the bad disk is replaced. Check with 
the manufacturer of the array enclosure if you are not sure whether it sup-
ports hot swapping
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4 Do whatever you need to do with the array disks. Data I/O 
resumes automatically at the end of the pause period.

Verifying Array Integrity
Use this option to verify the integrity of redundant data stored on 
RAID 1 arrays. When you run this operation, Adaptec CI/O Work-
station Array Management Software checks the array for miscom-
pares and corrects them automatically. A miscompare occurs when 
some part of the data on a mirrored disk pair in a RAID 0/1 or 
RAID 1 array does not match.

In Adaptec CI/O Workstation Array Management Software you can 
schedule the Verify operation to run later or schedule it to run at a 
regularly occurring interval. We recommend that you schedule a 
verification of all arrays at least once a week. See Setting Scheduling 
Options on page 6-1 for more information.

Follow these steps to verify the integrity of redundant array data:

1 Select Configuration from the View menu. The Storage Con-
figuration window appears.

2 Click on the array icon . The Operations button becomes 
active.

3 Click the Operations button.
5-6



Performing Operations on Arrays and Other System Devices
4 When the Array Operations dialog box appears, click the 

 button to verify the data on the array. The Scheduler 
dialog box appears, as shown in Figure 5-2.

5 Leave the autofix box checked so that data mirroring mis-
matches will be corrected automatically.

6 Select Immediate if you want to verify parity immediately, or 
select Scheduled if you want to schedule the operation for a 
future time.

7 If you select Scheduled, enter a start time, start day of the 
week, and other information. (See Setting Scheduling Options on 
page 6-1 for more information.)

8 Select an Execution Priority - high, medium, or low. This 
determines how much system resources are devoted to the 
operation. A high priority means the Verify operation will use 

Figure 5-2. Scheduler Dialog Box
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a lot of system resources, which may slow down other system 
activity.

9 Click OK to start the operation (if you selected Immediate) or 
to enter it on the list of scheduled activities.

You can open a Watch window to monitor the progress of the opera-
tion as it is running. See Monitoring Activities that are Running on 
page 6-5 for more information.

Blinking Array Drive Lights
You can issue a command to blink the drive lights of all the disks in 
a selected array. This allows you to see which physical drives actu-
ally form the array.

Follow these steps to blink the drive lights of the disks in an array:

1 Select Configuration from the View menu. The Storage Con-
figuration window appears.

2 Click on an array icon in the right side of the dialog box. The 
Operations button becomes active.

3 Click the Operations button.

4 When the Array Operations dialog box appears, click the 

 button.

5 Observe the blinking drive lights to determine which disks are 
members of the array.

6 Click OK in the popup box to stop the drive lights from 
blinking.
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Reactivating an Off-line Array
An array may go off-line because a cable is disconnected, because a 
disk failed, or because you mistakenly removed the wrong disk 
while trying to replace a failed disk. In these situations, the array 
shuts down temporarily. Depending on the reason why the array 
went off-line, it is possible that you can reactivate it and resume I/O 
without data loss. See Responding to an Off-line Array on page 9-3 for 
more information.

After you correct any hardware problems, follow these steps to reac-
tivate an off-line array:

1 Select Configuration from the View menu. The Storage Con-
figuration window appears.

2 Click on the grayed-out icon of the off-line array. The Opera-
tions button becomes active.

3 Click the Operations button.

4 When the Array Operations dialog box appears, click the 

 button.

5 When the message appears, confirm that you want to reacti-
vate the array. Be sure that any hardware problems are cor-
rected before you do this.

6 If the array is fault-tolerant, run a Verify operation on it (see 
Verifying Array Integrity on page 5-6). If it is a RAID 0 array, run 
chkdsk to check the array integrity.

Changing an Array Name
When you create an array, you assign it a name of your choosing. 
This name appears beneath the array icon and in many of the win-
dows and dialog boxes. It is also used to identify the source of event 
notifications. You can change this name at a later time, if necessary.

Follow these steps to change the name of an existing array:

1 Select Configuration from the View menu. The Storage Con-
figuration window appears.
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2 Click the icon of the array whose name you want to 
change. The Operations button becomes active.

3 Click the Operations button.

4 When the Array Operations dialog box appears, click the 

 button. The Change Name dialog box appears.

5 Type the new array name and click OK.

6 When the confirmation message appears, confirm that you 
want to change the array name. This change appears immedi-
ately in the Storage Configuration window.

Forcing a Spare
Forcing a spare means issuing a command for a spare disk to replace 
a specific disk in an array. You can do this if the array disk is not per-
forming well and is giving some indication that an array member 
may fail soon. (If an array member actually does fail, a spare 
replaces it automatically without requiring you to force a spare.)

Follow these steps to force a spare:

1 Be sure that one or more spares are available for the array. 
These can either be dedicated spares for the array or spares 
from a spare pool. See Creating Dedicated Spares or a Spare Pool 
on page 3-12 for more information on configuring spares.

2 Select Configuration from the View menu. The Storage Con-
figuration window appears.

3 Click on the icon of the array with the suspect disk. The Opera-
tions button becomes active.

4 Click the Operations button.

5 When the Array Operations dialog box appears, click the 

 button. This button is grayed out if no spares are 
available.

6 Select the disk that you want to replace.
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7 Click OK to replace this disk with a spare.

8 When the confirmation message appears, confirm that you 
want to replace the disk with the spare. At this point the spare 
is automatically activated to replace the disk.

If there is a pool of available spares, you cannot control which disk 
from the pool is activated when you force a spare. You can control 
this if there is only one dedicated spare or one pool spare. If both ded-
icated spares and pool spares are available, the dedicated spares are 
used first. An error message appears if the spare is not at least as 
large as the smallest disk in the array. If this happens, add a larger 
spare.

Performing Spare Operations
Here is a list of the spare operations available in Adaptec CI/O 
Workstation Array Management Software. (Note that Deleting a 
Spare is covered in an earlier chapter):

■ Testing All Spares on page 5-11

■ Blinking the Spare Drive Light on page 5-13

■ Deleting a Spare on page 3-15

Testing All Spares
Reliable spares must be available to immediately (and automati-
cally) replace any array disk that fails. Spares should be tested regu-
larly to assure that they are working properly. We recommend that 
you test all spares daily. You can run this operation immediately by 
issuing a command, or you can use the Scheduler function to set up 
a recurring check of all the spares at a later time.

Note: When you install Adaptec CI/O Workstation Array 
Management Software it automatically sets up a daily Test 
All Spares operation. We recommend that you leave this 
default setting so that all spares are tested regularly.

Follow these steps to test all spares:

1 Select Configuration from the View menu. The Storage Con-
figuration window appears.
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2 Click on the icon of any spare on the right side of the dialog 
box. The Operations button becomes active.

3 Click the Operations button.

4 When the Spare Operations dialog box appears, click the 

 button. The Scheduler dialog box appears, as shown in 
Figure 5-2 on page 5-7.

5 Select Immediate if you want to test all spares immediately, or 
select Scheduled if you want to schedule the operation for a 
later time.

6 If you select Scheduled, enter a starting time, starting day, and 
other information.

7 Click OK to start the operation (if you selected Immediate) or 
to enter it on the list of scheduled activities.

8 When the confirmation message appears, confirm that you 
want to test the spares.

9 Read the popup message that appears when the test is com-
pleted. (The message is also recorded in the Historic Event 
Log.) If any spares failed the test, look at the spare disk icons in 
the Storage Configuration window. The icons of the failed 

disks will look like this .

10 Replace any failed disks immediately with good disks of at 
least the same capacity.
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Blinking the Spare Drive Light
You can issue a command to blink the drive light of a spare whose 
icon you have selected. This allows you to see which physical drive 
is the actual spare.

Follow these steps to blink the drive light of a spare:

1 Select Configuration from the View menu. The Storage Con-
figuration window appears.

2 Click on a spare icon in the right side of the dialog box. The 
Operations button becomes active.

3 Click the Operations button.

4 When the Spare Operations dialog box appears, click the 

 button.

5 Determine which disk light is blinking.

6 Click OK in the popup box to stop the drive light from 
blinking.

Performing Array Card Operations
If you select an array card icon, you have two operation options: 
Optimizing Performance and Graphing.

Optimizing Array Card Performance
Follow these steps to optimize array card performance by adjusting 
the Read and Write caching options:

1 Select Configuration from the View menu. The Storage Con-
figuration window appears.

2 Click on an array card icon in the left side of the dialog box. 
The Operations button becomes active.

3 Click the Operations button.
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4 When the Adapter Operations dialog box appears, click the 

 button. A list of arrays controlled by the array card 
appears.

5 Select the array whose caching options you want to change 
and click the Caching button. (Each array has its own Read 
and Write cache, so you must change the options separately for 
each device.) The Optimize Performance dialog box appears.

Note: Some RAID levels may not support the 
Read/Write caching feature. Unsupported functional-
ity is grayed out.

6 Change cache settings as needed. Follow the instructions in 
Using Read and Write Caching on page 7-1.

Graphing Array Card Performance
Follow these steps to view a graph of the array card I/O 
performance:

1 Select Configuration from the View menu. The Storage Con-
figuration window appears.

2 Click on an array card icon in the left side of the dialog box. 
The Operations button becomes active.

3 Click the Operations button.

4 When the Adapter Operations dialog box appears, click the 

 button. The CI/O Profiler window appears.

5 Follow the instructions in Graphing System Performance on 
page 7-6. The information you will see on the graph is a total 
for all arrays and disks controlled by the array card.
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Performing SCSI Channel Operations
If you select a SCSI channel icon, you can view a graph of I/O per-
formance on the channel.

Graphing SCSI Channel Performance
Follow these steps to view a graph of the I/O performance on the 
SCSI channel:

1 Select Configuration from the View menu. The Storage Con-
figuration window appears.

2 Click on a SCSI channel icon in the left side of the dialog box. 
The Operations button becomes active.

3 Click the Operations button.

4 When the Channel Operations dialog box appears, click the 

 button. The CI/O Profiler window appears.

5 Follow the instructions in Graphing System Performance on 
page 7-6. The information you will see on the graph is a total 
for all arrays and disks connected to the selected channel.
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Performing Disk Operations
You can perform the following disk operations with a single disk or 
with a disk that is an array member:

■ Blinking the Drive Light on page 5-16

■ Downing a Drive on page 5-17

■ Pausing I/O to a Disk Drive on page 5-18

You can also graph the disk performance of a single disk that is not 
an array member. See Graphing System Performance on page 7-6.

Blinking the Drive Light
You can issue a command to blink the light of a disk whose icon you 
have selected. This allows you to see which physical disk corre-
sponds to the disk icon.

Follow these steps to blink a drive light:

1 Select Configuration from the View menu. The Storage Con-
figuration window appears.

2 Click on a disk icon in the left side of the window. The Opera-
tions button becomes active.

3 Click the Operations button.

4 When the Drive Operations window appears, click the  
button.

5 Observe which disk light is blinking.

6 Click OK in the popup box to stop the drive light from 
blinking.
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Downing a Drive
Use this option to stop all data I/O to a member of an array. You 
might need to do this if the disk generates a S.M.A.R.T.1 alert indi-
cating that it is about to fail. When you down an array member, a 
spare is activated immediately (if available) to replace it, and a 
reconstruct is triggered for RAID levels that support it.

Note: The Down a Drive command can only be used for 
array members, not for spare disks or single disks.

Follow these steps to down a disk:

1 Select Configuration from the View menu. The Storage Con-
figuration window appears.

2 Select the icon of the disk you want to down.

3 Click the Operations button.

4 When the Drive Operations dialog box appears, click the 

button. If a spare is available, it replaces the downed 
disk immediately and a reconstruct of the array is triggered.

5 Wait until the Reconstruct operation is completed.

1 S.M.A.R.T. stands for Self-Monitoring, Analysis and Reporting Technology. 
Hard disk drives that support this technology continually analyze their per-
formance and generate an alert if they determine that the disk is likely to fail 
soon. Adaptec CI/O Workstation Array Management Software generates 
an event notification if it receives this alert, giving you an opportunity to 
replace the disk before it actually fails.
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Pausing I/O to a Disk Drive
Use this option to pause data I/O on a disk drive. You might need to 
do this if you want to replace a disk in an array enclosure. If your 
computer system has a special array enclosure that supports hot 
swapping1, you can replace a disk without pausing I/O.

When you pause I/O to a disk drive, all other devices on the SCSI 
channel(s) are paused as well. I/O resumes automatically at the end 
of the pause period. The Pause I/O command is disabled if a Verify, 
Reconstruct, or Initialize operation is running.

Note: You can pause data I/O for up to 120 seconds. This is 
enough time to replace a bad disk in an array enclosure, but 
not enough time to replace a bad disk inside a regular com-
puter case. If the array disks are not in an array enclosure, 
simply shut down the system, replace the bad disk, and 
restart the system.

Follow these steps to pause data I/O to a disk:

1 Select Configuration from the View menu. The Storage Con-
figuration window appears.

2 Select the icon of the disk you want to pause.

3 Click the Operations button. When the Array Operations dia-

log box appears, click the  button.

4 When the Pause I/O dialog box appears, enter a pause interval 
that does not exceed the maximum allowable pause period 
(120 seconds), and click OK to pause the disk. Wait a few sec-
onds until data I/O stops.

1 Hot swapping support means that the array enclosure electrically isolates the 
bad disk’s SCSI connector from the SCSI bus while the disk is being 
swapped to prevent data corruption. Data can still be transferred to and 
from the remaining good disks while the bad disk is replaced. Check with 
the manufacturer of the array enclosure if you are not sure whether it sup-
ports hot swapping
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5 Do whatever you need to do to the disk. Be sure to complete 
your work before the pause period expires. I/O resumes auto-
matically at the end of this period.

❒
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Scheduling and Monitoring 
Array Operations
Adaptec CI/O Workstation Array Management Software enables 
you to schedule some kinds of operations to run at a later time, or to 
schedule them to run at regularly recurring intervals. You set up 
these scheduled jobs when you give the command to run the activ-
ity, as described in Verifying Array Integrity on page 5-6, Reconstruct-
ing an Array on page 5-2, and Testing All Spares on page 5-11.

Setting Scheduling Options
The Scheduler dialog box allows you to schedule the Reconstruct an 
Array, Verify Integrity of Array, and Test All Spares operations. 
Reconstruct an Array is a one-time event for which you can enter a 
date and time. Verify Integrity of Array and Test All Spares can be 
scheduled as hourly, daily, or monthly recurring events. The Sched-
uler appears automatically when you define a new scheduled 
operation.
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Follow these steps to set scheduling options for a newly added 
operation:

1 Define a new scheduled operation: Reconstruct an Array, Ver-
ify Integrity of Array, or Test All Spares. The Scheduler dialog 
box appears, as shown in Figure 6-1.

2 Select Immediate to perform the action immediately or Sched-
uled to schedule it for later.

3 If you select Scheduled, select Once, Periodically, Daily, or 
Weekly. Enter other information such as day of the week or 
start time/date, as required.

Note: If you are scheduling an array reconstruct, you 
can only select the Once option.

4 Click OK to record the scheduling options. You may be 
prompted to confirm the activity.

Figure 6-1. Scheduler Dialog Box
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Viewing and Managing Scheduled Activities
You can view information about scheduled and currently running 
activities in the Array Activity Monitor window. You can abort 
activities that are running or delete scheduled activities.

Note: When you install Adaptec CI/O Workstation Array 
Management Software it automatically sets up a daily Test 
All Spares operation.

Follow these steps to view and manage scheduled activities:

1 Select Activities from the View menu. The Array Activity 
Monitor window appears, as shown in Figure 6-2.

2 Select an activity icon from the left part of the window. Infor-
mation about the activity is shown in the window. Each kind of 
activity has a distinctive icon. The icon labels indicate which 
array or spare the activity applies to.

Figure 6-2. Array Activity Monitor Window
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To view more detailed information about the activity, double-
click the activity icon. The Scheduler dialog box appears, as 
shown in Figure 6-1. Click Cancel to close the dialog box.

3 If you want to change the priority of a Verify or Reconstruct 
operation that is currently running (as indicated by a moving 
icon), select the activity icon on the left of the window and then 
click Change Priority. When the Change Priority dialog box 
appears, select an option and click OK.

Note: The priority change applies only while the activ-
ity is running this time. If it is a regularly scheduled 
activity, the next time it runs it will have the priority 
originally assigned to it. You cannot change the prior-
ity of an Initialize or Test all Spares operation that is 
currently running.

4 If you want to delete an activity that is not currently running, 
select its icon and click the Delete button. After you confirm 
the command, the activity is deleted from the list.

5 If you want to abort a currently-running activity, select its icon 
and click the Abort button. After you confirm the command, 
the activity stops running immediately. If this is a regularly 
recurring activity, such as a nightly test of all spares, it will run 
again in the future at the next scheduled time. Use Abort and 
then Delete if you want the activity to never run again.

6 Click the Watch button to open a small window to monitor the 
selected, currently running activity. See the following section 
for more information.
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Monitoring Activities that are Running
You can open one or more Watch windows to monitor currently-
running array activities. You can leave these small windows open 
while you continue doing other work on the computer.

When a Verify operation completes, the Watch window shows the 
total number of miscompares. A miscompare occurs when some part 
of the data on a mirrored disk pair in a RAID 1 array does not match. 
If you checked the Auto Correct box in the Verify dialog box, the 
miscompares are automatically fixed.

Follow these steps to monitor activities that are running:

1 Select Activities from the View menu. The Array Activity 
Monitor window appears.

2 Select the icon of a currently-running activity from the scrolla-
ble list at the top of the window.

3 Click the Watch button. A small Watch window for this activ-
ity appears, as shown in Figure 6-3. Each window has a per-
cent complete graph and a Status field (OK, Done, Failed). If a 
Verify operation is running, there is also a field listing the num-
ber of miscompares found. Click Close to close the Watch win-
dow after the activity has completed.

❒

Figure 6-3. Watch Window
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Optimizing and Monitoring 
System Performance
Using Read and Write Caching
Your Adaptec array card has a built-in, onboard Read/Write caching 
feature that allows faster data I/O to arrays controlled by the card. 
(Caching is done on the card itself, not on the arrays.)

■ A Read Cache improves I/O performance by anticipating 
which data is likely to be read next and keeping that data in 
cache memory on the array card. When the application actu-
ally needs the data, it can read it in much faster from the 
onboard cache than from disk.

■ A Write Cache improves I/O performance by temporarily 
storing data that needs to be written to disk in a cache on the 
adapter card and then writing it to disk moments later when 
there is less system activity. (Data can be written much faster to 
the cache than to the disk.) Moreover, the read performance 
improves if the application needs to immediately read the data 
that was just written to the write cache.

Adaptec CI/O Workstation Array Management Software automati-
cally enables Read and Write caching for all arrays controlled by the 
array card. To achieve the best I/O performance, we recommend 
that you leave the caching options at their default settings. If you are 
an advanced user, read the information in this chapter to learn how 
to change the caching options. This may enable you to achieve addi-
tional I/O improvements. You can set the caching options individu-
ally for each array controlled by the adapter card.
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Note: The Adaptec Web Site at 
http://www.adaptec.com/RAID has some specific tips for 
optimizing your system’s caching configuration.

Follow these steps to enable or disable Read or Write caching for an 
array controlled by the Adaptec array card:

1 Select Configuration from the View menu. The Storage Con-
figuration window appears.

2 Select an array icon and Click the Operations button.

Some RAID levels may not support Read/Write caching. 
Unsupported functionality is grayed out.

3 When the Array Operations dialog box appears, click the 

button. The Optimize Performance dialog box appears, 
as shown in Figure 7-1.

Figure 7-1. Optimize Performance Dialog Box
7-2



Optimizing and Monitoring System Performance
Note: To get an overview of how much Read/Write 
cache is used and how much is available for all arrays 
controlled by an array card, select an array card icon. 

Click the Operations button and the button. 
(This button is grayed out if caching is not enabled for 
any arrays.) You will see a list of arrays for which 
caching is enabled and the cache settings for these 
arrays. Double-click any array name (or highlight it 
and click the Caching… button) to change its cache 
settings.

4 Read the general information at the top of the Optimize Perfor-
mance dialog box. This includes the total cache available on 
the array adapter and the amount of cache that is currently 
available. (The Target device is the name of the array whose icon 
you chose.)

5 Select or deselect the Caching Enabled check box. This is the 
top-level control for all caching on this array. When you enable 
caching, Adaptec CI/O Workstation Array Management Soft-
ware assigns default values to the Read and Write Cache.

You can click the Restore Defaults button to restore these 
defaults.

6 If you wish, select a Cache block size and a Device cache size in 
blocks. Read and Write caching options are defined in terms of 
blocks, not KBytes.

– The block is the basic unit of measurement, in KBytes, for 
data stored in a cache.

– The Cache block size is the unit of cache memory. The Cache 
size multiplied by the cache block size equals the physical 
amount of memory on the array adapter that is used for 
this system device. For example, if the cache block size is 
4 KBytes and there are 256 blocks in the cache, the total 
cache size is 1024 KBytes.
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7 If you enabled Caching, you can select or deselect the Read 
Caching and Write Caching check boxes. When you select one 
of these options, the Advanced button is enabled. (See the fol-
lowing two sections if you want to set advanced Read or Write 
caching options.)

8 Click OK to enter changes to the caching options.

Setting Advanced Read Caching Options
Do not change the Advanced Read Caching options unless you 
clearly understand how the changes will affect your system’s perfor-
mance. There are two Read caches: the Demand Cache and the 
Look-ahead Cache. Options for these caches can be adjusted sepa-
rately for each array on your system.

■ The Demand Caching setting defines the maximum Read 
command size (stated as a number of data blocks) that will be 
cached. Demand Caching can greatly improve I/O perfor-
mance if your application typically reads data and then reads it 
again soon afterwards. For example, if Demand Caching is set 
to 4 blocks and the operating system issues a Read command 
for 4 blocks of data, all of the demand data is cached. However, 
if the operating system issues a Read command for 5 (or more) 
blocks of data, none of the demand data is cached.

■ The Look-ahead Caching factor is a multiplier to the com-
mand size that defines the maximum number of data blocks 
that will be stored in the Look-ahead Cache in addition to the 
amount of data requested by the Read command. Look-ahead 
caching can greatly improve I/O performance if your applica-
tion typically reads data in sequential blocks. For example, if 
Look-ahead caching is set to 16 and the operating system 
issues a read command, the demand data is cached if the com-
mand is less than or equal to 4 blocks, and the next (sequential) 
16x4 blocks of data is stored in the Look-ahead Cache.
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Setting Advanced Write Caching Options
Do not change the Advanced Write Caching options unless you 
clearly understand how the changes will affect your system’s perfor-
mance. There are two Write caches: the Write-back Cache and the 
Write-through Cache. Options for these caches can be adjusted sepa-
rately for each array on your system.

■ The Write-back Caching setting defines the maximum Write 
command size (stated as a number of data blocks) that will be 
cached in the Write-back Cache. When the Write command is 
issued, the data is quickly written to the cache. When the 
buffer is needed or when there is free time on the bus, the data 
is written from the cache to the disk. For example, if Write-back 
Caching is set to 4 blocks and the operating system issues a 
command to write up to 4 blocks of data, the data is stored in 
the Write-back Cache until it can be written to disk. However, 
if the operating system issues a Write command for 5 (or more) 
blocks of data, nothing is stored in the Write-back Cache.

Caution: It is possible for data to be lost if the power to 
the computer is interrupted while the data is in the 
Write-back Cache, before it is written to disk. To avoid 
this risk, set this parameter to zero. If you do use 
Write-back Caching, we recommend that you back up 
your system data regularly.

■ Write-through Caching is the same as Write-back Caching, 
except that the data is immediately transferred from the cache 
to disk before sending the status to the host system. The differ-
ence between the Write-back Caching setting and the Write-
through Caching setting defines the maximum Write com-
mand size beyond which the write data will not be cached at 
all. The data is written to disk and also stored in the cache. This 
enables faster I/O performance if the application needs to read 
the data that was recently written. The Write-through Caching 
setting must always be greater than the Write-back Caching 
setting.
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Graphing System Performance
Adaptec CI/O Workstation Array Management Software allows you 
to view dynamically updated performance graphs for the Adaptec 
array card and for device that the card controls. You can use this 
information to evaluate your system’s I/O performance and, possi-
bly, to improve performance by changing the caching parameters or 
by distributing the workload between multiple servers.

Follow these steps to view a graph of system performance:

1 Open the Storage Configuration window and select the icon of 

the array adapter , array , channel , or 

disk whose performance you want to graph. Click the 
Operations button.

2 When the Operations dialog box appears, click the  
button. The CI/O Profiler window appears, as shown in 
Figure 7-2.

Figure 7-2. CI/O Profiler Window
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3 View the information on the graph. If you selected an array 
card, the graph shows information for all devices controlled by 
the array card. Figure 7-2 shows an area graph for a selected 
array. The graph displays the percentage of total Read cache 
hits compared to the total number of read commands.

– A Read cache hit occurs when the operating system issues 
a Read command for data that is in the Demand cache or 
the Look-ahead cache.

– A Write cache hit occurs when the operating system issues 
a Read command for data that is in the Write-back or Write-
through cache.

4 Perform any of the following operations on the graph (if the 
toolbar does not appear, select Toolbar from the View menu):

– Pause the updating of the graph by clicking the  but-
ton on the toolbar.

– Resume the updating of the graph by clicking the  
button on the toolbar.

– Toggle the auto-scaling feature on or off by clicking the 

 button on the toolbar.

– Zoom in for a closer look at the graph data by clicking the 

button on the toolbar, or zoom out by clicking the 

 button.

– Toggle the horizontal and vertical graph grid on or off by 

clicking the  button on the toolbar. (You can toggle the 
horizontal and vertical grids separately in the Show sec-
tion of the Profiler Graph Properties dialog box, as 
described on page 7-11.)
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– Clear all data from the graph by clicking the  button 
on the toolbar. The graph will continue updating with new 
data.

– Save a graphic image of the current graph to the Windows 
Clipboard by selecting Copy Graph from the Edit menu. 
You can then paste the image into another application and 
print it.

5 If you want to change the graphing options, such as the type of 
data displayed or the measurement scale of the data, click the 

 button on the toolbar and follow the directions in the 
next section.

6 Select Exit from the File menu to close the CIO Profiler. If you 
wish, you can select a different array or disk in the Storage 
Configuration window and open a new graph for that device.

CI/O Profiler Performance Tips
CI/O Profiler graphs will update more efficiently and use less mem-
ory if you follow these tips:

■ Use Line and Area graphs with the Hybrid updating option

■ Keep the profiler window small to reduce updating overhead.

■ Change the display color palette to 256 colors or 16 colors.

■ Increase the Update interval to 3, 4, or 5 seconds.
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Changing the Graphing Options

To change the graphing options in the CI/O Profiler, click the  
button on the toolbar. The Profiler Graph Properties dialog box 
appears, as shown in Figure 7-3.

Here is a brief description of the graph properties you can change in 
this dialog box.

■ Measurement: You can select these options from the drop-
down Measurements menu:

– Cache hits: select this measurement to display the amount 
(or percentage) of total Cache hits compared to the total 
Read commands.

– Reads in bytes: select this measurement to display the total 
number of Read commands, as measured in MBytes or 
KBytes, not as a percent.

Figure 7-3. Profiler Graph Properties Dialog Box
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– Reads sorted by request size: select this measurement to 
display a histogram of the total number of Read com-
mands. The histogram has twelve data points along the 
horizontal axis (X-axis), ranging from 512 bytes to 
> 1 MByte. A dynamically changing bar of data above each 
data point shows the percentage of Read commands in 
each size category. By observing the histogram, you can see 
which sizes of Read commands are issued most often. You 
may be able to use this information to change the size of 
the Read/Write caches to enable more cache hits.

– Writes in bytes: select this measurement to display the 
total number of Write commands, as measured in bytes, 
not percent. (You can select either MBytes of KBytes as the 
scale of measurement.)

– Writes sorted by request size: select this measurement to 
display a histogram of the total number of Write com-
mands. The histogram has twelve data points along the 
horizontal axis (X-axis), ranging from 512 bytes to 
> 1 MByte. A dynamically changing bar of data above each 
data point shows the percentage of Write commands in 
each size category. By observing the histogram, you can see 
which sizes of Write commands are issued most often. You 
may be able to use this information to change the size of 
the Write caches to enable more Write cache hits.

■ Graph Type: Depending on which measurement you select, 
some of the following graph types are available (not all types 
are available for each measurement):

– Line: shows a simple line graph with a data point every 
second.

– Cluster Bar: shows a cluster of four small color-coded bars 
for each data point—one bar representing each of the four 
caches. (Supported by Cache Hits graph only.)

– Stacked Bar: shows a bar graph with one composite bar for 
each data point. Data from each cache is represented as a 
separate, color-coded segment of the bar. (Supported by 
Cache Hits graph only.)

– Area: (see Figure 7-2) Similar to a line graph, but with the 
area beneath the line filled in.
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– Histogram: this is the only supported graph type for Reads 
sorted by request size or Writes sorted by request size. 
(Histograms are described above, under Measurement.)

– Bar: shows a single, non-composite bar for each data point, 
representing the total number of Reads and Writes.

■ X-Axis: You can select these options for the X-Axis (horizontal 
axis):

– Data Points: the number of data sampling points displayed 
across the X-axis of the graph. Select a number from the 
drop-down menu or type a whole number.

Note: The actual display of data points may vary 
somewhat, depending on the size of the graph on 
the screen. Data points are fixed at twelve for his-
tograms and cannot be changed.

– Update Interval: The interval, in seconds, at which Read 
and Write data is sampled and updated. We recommend 
that you select a 2-second update interval. You can type a 
different whole number or select a number from the drop-
down menu.

– Time Labels: select the check box to display the time labels 
below the graph or de-select it to hide them.

■ Show: select or deselect the check boxes to display or hide the 
following:

– X-Axis grid: the horizontal grid lines

– Y-Axis grid: the vertical grid lines

– Object Info bar: The Object Info bar, which appears below 
the toolbar (see Figure 7-2), lists information about the 
device that is being graphed.

– Averages: only supported by bar graphs. When selected, 
this option displays a dotted-line, color-coded running 
average of the data that is displayed on bar graphs.
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■ Y-Axis: You can select these options for the Y-Axis (vertical 
axis). Not all options are supported for all types of graphs:

– Limit: To limit the maximum range of the Y-axis, select the 
Limit check box and type or select a maximum number. If 
you do not set an upper limit, the scale of the axis changes 
dynamically to adjust to the peak data value shown on the 
graph. These data “spikes” may make the smaller data val-
ues on the graph more difficult to read, so you may wish to 
limit the upper range of data shown.

– Unit: Specifies the unit of measurement used on the Y-Axis:

If the graph is displaying Cache hits, only Percent is 
supported.

If the graph is displaying Reads in bytes or Writes in 
bytes, you can select KBytes or MBytes.

If the graph is displaying Reads sorted by request size or 
Writes sorted by request size, only Percent is supported.

– Second Y-Axis: If selected, this option displays a second set 
of Y-axis labels on the right side of the graph.

■ Updating Options: You can select the following options to 
control how the selected graph is updated on the screen:

– Sweep: When this option is selected, data on the graph is 
filled in starting from the left and moving to the right. 
When the entire graph is filled in, the data starts in again 
on the left, overwriting the previous data. A small vertical 
hash mark at the top of the graph marks the most recently 
updated data point.

– Scrolling: When this option is selected, data on the graph is 
filled in starting from the right and scrolling to the left 
across the graph. Data then scrolls off the left side of the 
graph and disappears. New data continues to appear on 
the right.

– Hybrid: This updating option combines elements of Sweep 
and Scrolling. Data fills in the graph starting from near the 
right edge, scrolls to the left, and disappears from the 
screen. The scrolling occurs in such a way that there is usu-
ally an open margin on the right side of the graph.
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■ Colors: Click this button to display the Graph Colors dialog 
box. You can change the background color of the window and 
the graph. You can also change the colors in which the various 
kinds of data are displayed in the graph.

Other Performance Tips
■ To achieve the best array I/O performance, we recommend 

that you use disks of the same capacity and same model in an 
array.

■ You can optimize array I/O performance by selecting a RAID 
level for the array that best meets your needs for data reliabil-
ity, read/write performance, and capacity utilization. In gen-
eral, you can achieve the best I/O performance by striping 
data across several disks in an array. (See Selecting a RAID Level 
for an Array on page 9-4 for more information.)

■ You can achieve faster array I/O performance by not connect-
ing slower devices such as tape drives and CD-ROM drives to 
the same SCSI channel as the array disks.

❒
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Setting Security Options
Adaptec CI/O Workstation Array Management Software has simple 
but effective password protection to prevent unauthorized changes 
to array configuration. Users who know the password can view 
array information and can issue commands to add and delete arrays, 
add and delete spares, and make other changes to array configura-
tion. Users who do not know the password can view array configu-
ration information but cannot change it.

Setting the Initial Password
Follow these steps to set the initial Adaptec CI/O Workstation Array 
Management Software password after installing the program:

1 Double-click the  icon in the Adaptec CI/O Workstation 
Array Management Software group to start the program.
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2 Select Change Password from the View menu. The Change 
Password dialog box appears, as shown in Figure 8-1.

No Old Password is required, because none has yet been 
defined.

3 Type the new password in the New Password field.

Passwords are case sensitive and can be up to 16 characters 
long, including the characters A-Z, a-z, and 0-9. Spaces are not 
allowed. Long passwords with a mixture of numerals and let-
ters provide better security. Do not use obvious passwords like 
your name, the name of a family member, your birthday, your 
social security number, etc.

4 Type the new password again in the Confirm Password field.

5 Click OK to register the initial password.

Changing the Password
Follow these steps to change the Adaptec CI/O Workstation Array 
Management Software password:

1 Select Change Password from the View menu. The Change 
Password dialog box appears, as shown in Figure 8-1.

2 Type the existing password in the Old Password field.

3 Type the new password in the New Password field.

Figure 8-1. Change Password Dialog Box
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Passwords are case sensitive and can be up to 16 characters 
long, including the characters A-Z, a-z, and 0-9. Spaces are not 
allowed. 

4 Type the new password again in the Confirm Password field.

5 Click OK to accept the new password.

Setting Password Time-out Preferences
The password time-out preferences allow you to control the way in 
which users are prompted to enter the Adaptec CI/O Workstation 
Array Management Software password when they issue commands 
to change the system’s array configuration.

Follow these steps to change the Adaptec CI/O Workstation Array 
Management Software password time-out preferences:

1 Click the  button on the toolbar. The Preferences dialog 
box appears.

2 Select one of the three Password Time-out preferences listed on 
the right of the dialog box. Here is a description:

– No Password Time-out: Requires you to enter the pass-
word only the first time (during each session) that you issue 
a command to change array configuration. This option pro-
vides less security than the others: if you leave your work-
station unattended after entering the password, another 
person can issue commands from the workstation without 
being prompted for the password.

– Always Require Password: Requires you to re-enter the 
password every time you issue a command to change array 
configuration.

– Enter Password Time-out Interval: Requires you to re-
enter the password at the stated time-out interval, when-
ever you issue commands to change the array configura-
tion. For example, suppose that the time-out interval is 10 
minutes. You start the program at 9:00 and issue a com-
mand to create a new array. You are prompted to enter the 
password before the command is accepted. After entering 
the password, you issue a command at 9:05 to add spares 
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to the spare pool; no password is required. At 9:16 you 
issue a command to delete an array; since you are beyond 
the 10-minute interval, you are prompted again to enter the 
password before the command is executed.

3 Click OK to accept the password time-out change. You may be 
prompted to enter the password at this point.

❒
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Managing Arrays and 
Spares
This chapter has information on what to do when you need to 
replace a failed drive, physically reconfigure the disks in your com-
puter, and perform other tasks.

Responding to a Critical Array
A fault-tolerant RAID 1 array enters Critical status if one disk in the 
array fails. The array continues to operate normally, but you will 
lose data if another disk in the array fails.

If a spare disk is available, the array management software will 
reconstruct the Critical array automatically. When the reconstruct is 
complete, the array returns to Fault-tolerant status. If no spare disk 
is available, you should respond immediately to minimize the possi-
bility of data loss. The most effective strategy is prevention: be sure 
that arrays are always protected by a spare pool or by dedicated 
spares!

In addition, you should monitor the status of arrays at all times with 
Adaptec CI/O Workstation Array Management Software to detect 
arrays whose status is Critical. You can tell that an array is in critical 
status if its icon in the Storage Configuration window looks like this 

.
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Follow these steps to return a Critical array to Fault-tolerant status:

1 Click the array icon  and observe the disk icons of the 
array members on the left of the screen. One of the icons 

should look like this , indicating that the disk has failed.

2 Click the  icon and then click the Operations button.

3 When the Drive Operations window appears, click the 

button to blink the drive light on the failed disk.

4 Observe which drive light is blinking. This is the disk that you 
need to replace. If no lights are blinking, this could mean one 
of the following:

a The disk is still connected but has failed so badly that it 
cannot respond to the Blink command. Try blinking the 
drive lights of the array disks that have not failed. You may 
be able to determine by a process of elimination which disk 
has failed.

b The disk has been removed or its power cord or SCSI cable 
has been disconnected.

If an array disk has been disconnected or removed but the 
computer has not been rebooted, the icon for this disk will 
still appear in the Storage Configuration window. If you 
know that the disk was disconnected accidentally and has 
not actually failed, reconnect the drive, issue a Rescan com-
mand, and reconstruct the array.

If the computer has been rebooted since the disk was dis-
connected, the disk icon will not appear. To determine if a 
disk is “missing” from an array, double-click the array icon, 
and read the Status field at the top of the Array Informa-
tion dialog box. If this field says Missing member, a disk is 
missing from the array.

c The disk does not have an LED that indicates I/O activity.
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5 Pause I/O to the array before you continue.

Note: If the array disks are mounted inside the com-
puter case, do not use the Pause I/O feature. Instead, 
shut down the computer and disconnect the power. 
Then open the computer, replace the bad disk, replace 
the computer cover, and reconnect the power.

6 Replace the failed disk with a good disk, or replace the missing 
disk. (If you paused I/O, be sure to complete this step before 
the pause period expires.

7 After I/O resumes automatically, select the icon of the new 
disk, and issue a Create a Spare command.

8 When the spare has been created, select the array icon and 
issue a Reconstruct command, if necessary (it is possible that 
the reconstruct will start automatically at this point).

When the reconstruct is completed the array is in Fault-tolerant sta-

tus again, and the array icon will look like this .

Responding to an Off-line Array
You can tell that an array is in off-line status if the array icon in the 

Storage Configuration window looks like this: . There are 
several reasons for an array going off-line, as described below:

■ Both disks of a mirrored pair in a Critical RAID 1 array have 
failed.

If this happens, delete the off-line array, create a new array, and 
restore the data from your most recent backup. You cannot 
recover the array data if a second disk fails.

■ You were trying to replace a failed disk in a Critical RAID 1, 
array, but you mistakenly removed the wrong disk.

If this happens, reinsert the drive you mistakenly removed and 
issue the Reactivate Array command, which returns the array 
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to Critical status. Then replace the correct disk and reconstruct 
the array.

■ A cable to a good drive in a RAID 1 array accidentally became 
disconnected, and the other disk of the mirrored pair had 
already failed.

If this happens, reconnect the cable, and use the Reactivate 
Array command to return the drive to Critical status. Then 
replace the failed disk and reconstruct the array.

Selecting a RAID Level for an Array
RAID means Redundant Array of Independent Disks. An array is a 
grouping of disks that, by means of array management software, 
appears to the computer’s operating system as one large disk. Part 
of the storage capacity of most kinds of arrays contains redundant 
information about the user data on the array1. If an array disk fails, 
the contents of the disk can be regenerated on a new disk from the 
redundant information on the other array disks.

Compared with single disks, arrays can provide one or more of 
these benefits:

■ improved Read and Write I/O performance by striping data 
across the disks in the array. This allows data to be read from 
or written to two or more disks simultaneously.

■ improved data reliability by storing redundant data to regener-
ate a failed array disk, as described above. (This applies to 
RAID 1 arrays; RAID 0 arrays do not store redundant data.)

■ improved capacity utilization by allowing you to manage a 
large number of disks as if they were one large disk. This can 
simplify the tasks of backing up data, creating directories, etc.

All disks of an array (including spares) must be connected to SCSI 
channels controlled by the same Adaptec array card. You can create 
dedicated spare disks for each RAID 1 array. You can also create a 
pool of spares that can be used by any RAID 1 array controlled by 
the Adaptec array card.2

1 RAID 0 arrays, which do not store redundant data, are an exception to this 
definition.

2 A disk in a spare pool can only be used to replace a failed disk in an array 
if it is at least as large as the smallest disk in the array.
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The array management software and firmware support RAID 0 and 
RAID 1 arrays. The advantages, disadvantages, and requirements of 
these RAID levels are as follows:

RAID 0 Arrays
Maximum Disks Allowed: 163

Minimum Disks Allowed: 14

In a RAID 0 array, data is distributed, or striped, across the disks in 
the array. The capacity of the array is approximately equal to the 
combined capacity of the physical disks. The I/O performance of a 
RAID 0 array is much better than that of a single physical disk 
because multiple reads and writes can be handled in parallel and 
because when large files are accessed the striped data is retrieved 
simultaneously from several disks.

RAID 0 arrays do not store redundant data and therefore are not 
true RAID applications. If one disk fails, the entire array fails and all 
data is lost. This means that the fault tolerance of a RAID 0 array is 
less than that of any single disk in the array. The term RAID 0 is 
widely used for these arrays, however, because they are conceptu-
ally similar to true RAID applications.

RAID 1 Arrays
Maximum Disks Allowed: 2
Minimum Disks Allowed: 2

RAID 1 arrays use a single pair of disks. They are called mirrored 
arrays because both disks in the pair contain the same data. When 
data is written to a RAID 1 array it is written to each disk in the pair. 
The read performance of a RAID 1 array can be much better than 
that of a single disk, while the write performance is slightly worse. 
Mirrored arrays are highly reliable because the data is still safe if one 
disk in the pair fails. They are more costly, however, because you 
only get one disk of actual storage capacity from the pair of disks.

❒

3 The maximum would be 15 disks if the system has a single SCSI channel.
4 One-disk RAID 0 arrays are used only to control the virtual device order of 

single disks.
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Configuration Settings
This appendix describes the configuration variables that control the 
appearance of the Adaptec CI/O Workstation Array Management 
Software user interface and the way in which array and system 
operations are carried out. The variables controlling the ArrayConfig 
program are the arconfig.ini file. The variables controlling the user 
interface appearance are in the Windows NT registry. The other vari-
ables are defined in a file called iomgr.ini. 

Many of the variables are configured for you once you install the 
software or start the program. If you are an advanced user and you 
want to customize your settings, you can edit the variables in the NT 
registry, or you can open iomgr.ini or arconfig.ini in a text editor and 
manually make changes.
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arconfig.ini
The arconfig.ini file is located on the ArrayConfigCA diskette. The 
variables in this file are described below. Variables and their values 
are not case-sensitive.

ExpressSetup=
When set to Yes (the default) this variable causes the Express Setup 
wizard to be displayed when ArrayConfigCA starts. When set to No, 
the Custom Setup Main Menu appears when ArrayConfigCA starts.

WriteSame=
This variable, when enabled, can speed up the formatting of array 
disks in some systems when you create a new array. By default, the 
line WriteSame=Yes is included in the arrayconfig.ini file, but it is 
remarked out and therefore disabled. If you want to enable 
WriteSame, open arconfig.ini in a text editor, delete the letters rem at 
the beginning of the line, and save the file. The next time you create an 
array, it should take less time to format the disks.

SparePool=
This variable enables or disables the option of creating a spare pool 
in ArrayConfigCA. This variable should be set to No, because this 
version of ArrayConfigCA does not support spare pools. (You can 
create a spare pool with Adaptec CI/O Workstation Array Manage-
ment Software.)
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Configuration Settings
iomgr.ini
The iomgr.ini file is located in the directory in which Adaptec CI/O 
Workstation Array Management Software is installed. The section 
name, for example [ARRAYOPERATIONS], and the variables under 
each section are described below.

[ARRAYOPERATIONS]

RecreatePriority=
This variable specifies the priority of the automatic Reconstruct opera-
tion. Valid values are Low, Medium, or High. The default is Medium.

VerifyIfDirty=
This variable specifies whether you want to start the Verify opera-
tion if the array is dirty (the array was not shut down properly). 
Valid values are Yes or No. The default value is No.

DriverMonitoringFrequencyInS ecs=
This variable specifies the maximum interval in seconds before 
Adaptec CI/O Workstation Array Management Software polls the 
driver. Any number of seconds can be specified; small values may 
affect performance, large values (greater than 10 seconds) may affect 
responsiveness to problems. The default value is 5.

[SYSTEM]

PauseEnabled=
This variable specifies whether the Pause I/O capability is enabled 
or disabled. Valid values are Yes and No. The default value is Yes.

ServerLogSizeInMegabytes=
This variable is used to limit the size of the Historical Log database 
file. The database will be truncated if it grows beyond the size speci-
fied by the parameter. The size can be specified in increments of 
1 MByte, up to a maximum of 10 MBytes.

StatisticsCollectionInterval=
This variable specifies the interval at which system statistics will be 
collected, assuming that the driver supports statistics collection. Val-
ues must be entered as whole numbers. The default value is 1.

WarnAfterFirstPFAEvent=
If set to Yes, this variable specifies that if SMART events (PFA) are 
received from any drive the first event will be reported as a Critical 
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event and all events after that will be reported as Warning events. If 
set to No, all SMART events will be reported as Critical. The default 
is Yes.

[TASKS]

TestAllSpares=
This variable schedules the TestAllSpares operation. These jobs are 
not written to the Scheduler Database and are scheduled every time 
iomgr.exe is started. The default setting is to test all spares at 
2:00 A.M. daily. Valid values are 

■ Yes,H—Starts test every hour on the hour. For example, 
TestAllSpares=Yes,H

■ Yes,D,Time—Starts test daily at a specified time, stated in 24-
hour time format. For example, TestAllSpares=Yes,D,11:34.

■ Yes,W,Day of the week,Time—Starts test weekly at a specified 
day and time (Day of the week: 0=Sun, 1=Mon, 2=Tues., etc.). 
For example, TestAllSpares=Yes,W,2,11:34 (starts every week 
on Tuesday at 11:34).

■ No—No tests are scheduled. For example, TestAllSpares=No.

[CAPABILITIES]

EnableRAID5=
This variable enables or disables the option of creating RAID 5 
arrays. This version of Adaptec CI/O Workstation Array Manage-
ment Software does not support RAID 5 arrays, so this variable 
should always be set to No.

EnableRAID10=
This variable enables or disables the option of creating RAID 0/1 
arrays. This version of Adaptec CI/O Workstation Array Manage-
ment Software does not support RAID 0/1 arrays, so this variable 
should always be set to No.
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User Interface Variables
The Adaptec CI/O Workstation Array Management Software user 
interface variables are located in the Windows NT registry under 
HKEY_LOCAL_MACHINE\SOFTWARE\Adaptec\Adaptec CI/O 
Array Management Software:

■ Config Path: REG_SZ: configs.dat
This is the storage path for the configuration file.

■ Display Activity: REG_DWORD: 0

If the value is non-zero, the application will display the Activ-
ity Monitor window on startup.

■ Display Config: REG_DWORD: 0x2
If the value is non-zero, the application will display the Storage 
Configuration window on startup.

■ Display Server Log: REG_DWORD: 0

If the value is non-zero, the application will display the His-
toric Event Log window on startup.

■ Display Server View: REG_DWORD: 0
If the value is non-zero, the application will display the Server 
View window on startup. (This is not applicable to the desktop 
version of Adaptec CI/O Workstation Array Management 
Software.)

■ End Date: REG_SZ: 12/31/1999

■ End Time: REG_SZ: 23:59:59

■ Notifications: REG_DWORD: 0

Popup Box is 0x1, Beep is 0x2, Flash Titlebar is 0x4, and None 
is 0x0. These values may be OR’ed together.

■ Server Name: REG_SZ: 

■ Severity: REG_DWORD: 0xd
Informational is 0x1, Warning is 0x4, and Critical is 0x8. These 
values may be OR’ed together.

■ Start Date: REG_SZ: 1/1/1990

■ Start Time: REG_SZ: 00:00:00

❒
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